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Copyright and Distribution

Level 9 was originally written by Glen Summers and version 3.0 was
developed from Glen’s source by David Kinder. This Macintosh port is by
Alan Staniforth <alan@apollonia.org>    . Glen makes no statement about
distribution anywhere in his source or binary distributions but as he has
made both publicly available I assume he has no objection to free distribution.
David Kinder has made version 3.0 Copyleft under terms of the Gnu General
Public License. Please see the file gpl.txt in the “Documentation” folder for
details; here is the short form:

This program is free software; you can redistribute it and/or modify it under the terms of
the GNU General Public License as published by the Free Software Foundation; either
version 2 of the License, or (at your option) any later version.

This program is distributed in the hope that it will be useful, but WITHOUT ANY
WARRANTY; without even the implied warranty of MERCHANTABILITY or
FITNESS FOR A PARTICULAR PURPOSE.  See the GNU General Public License for
more details.

You should have received a copy of the GNU General Public License along with this
program; if not, write to the Free Software Foundation, Inc., 59 Temple Place, Suite 330,
Boston, MA  02111-1307  USA

The current version of Level 9 (binary and source) should always be available
from the Interactive Fiction Archive by FTP:

<ftp://ftp.ifarchive.org//if-archive/Level 9/interpreters/Level 9/>     

or via the Web

<http://ifarchive.org/indexes/if-archiveXLevel 9XinterpretersXLevel 9.html >     

or the Web mirror (fastest)

<http://         mirror.ifarchive.org         /indexes/if-archiveXLevel 9XinterpretersXLevel 9.html >     

Warning!

There are some minor, documented1 instabilities in this port. (And no doubt
some undocumented ones as well!) It is unlikely, in normal use that it will
cause data-loss but if it decides to eat your email, hard disk, your dog,
spousal appurtenance2, children or yourself you are on your own. There is no
warranty, express or implied. You use it at your own risk!

                                                

1 See “Known Problems”.

2 For the politically correct.

mailto:alan@apollonia.org
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Conventions used in this Manual

Applications names generally appear in bold face.

Menu Choices and Button Names appear in 12 point Chicago.

Text from the game terminal is generally presented in 9 point
Monaco.

Introduction

History

Level 9 was a small British company that in the ten years 1981-1991 published
some of the best text adventure games written. They ceased publishing when
it became clear that the market for text adventures was dying and found
themselves unable to gain a foothold in the market for new forms of game. In
many cases the hardware and OS platforms on which their games ran no
longer exist and even where the hardware exists frequently the games fail to
run under the current OS versions. So those of us who still like to play them
have to use a third party interpreter. It was for  this purpose that Level 9 was
written in 1996 by Glen Summers. It has since been updated to handle a
larger range of game versions and to improve its LensLok and Manual
lookup protection bypasses. This version (Macintosh 2.1) of Level 9 is based
on version 3.0 of the Level 9 source.

Currently the main “reference” version is at 3.0 and this is my build of that
plus a few minor enhancements.

What happened to “Level 9 Console”
This replaces it. With one exception it does everything that “Level 9 Console”
did and does a lot more. That exception is: print. I haven’t added printing to
Level 9 yet but it should be possible.

Requirements

OS Requirements
Level 9 will probably run under MacOS version 7.1 and certainly under
MacOS version 7.6 to version 9.x3 and as a Carbon application on OS X. It is a
FATCarbon binary and will run on both 68K and PPC hardware. (Under Mac
OS 8.1-9.2 or Classic, even if CarbonLib is present, the Carbon version of the
code is not used. This is because of sluggish event handling in Carbon under
a classic OS.)

                                                

3 I have only been able to test under 7.6 (68K and PPC) and 9.1 and 9.2, both under PPC. If
any problems are encountered please let me know.
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Game Requirements
To play the games the interpreter needs the data files from the original
games. If your original game is from a platform where the game code and
data file were integrated — BBC, Spectrum, several others — it may still work
as Level 9 searches the file for game data. This also works with some kinds of
memory snapshots, such as the Spectrum .sna type.

If the  file is compressed (for example the Spectrum .z80 type snapshot) it
won’t work. In this case a utility is required to extract the data file from the
compressed file. For this purpose L9Cut, a utility written by Paul David
Doherty and again ported to the Mac by Alan Staniforth is available from the
Interactive Fiction Archive either via ftp:

<ftp://ftp.ifarchive.org//if-archive/Level 9/tools/>    

or the Web:

<http://ifarchive.org//indexes/if-archiveXLevel 9Xtools.html >    

L9Cut will deal with .z80 files but if you have some other Speccy snapshot
format you may need the converter SPConv. I have done a rough port of that
and may release it at some point but it isn’t a priority at the moment.

• Note that no file used by Level 9 must have a “path name” (the hard
disk name, all the enclosing folders and the file name concatenated
together) that is more that 255 characters long. This may change in the
future .

Graphics Requirements
Version 3.0 of Level 9 supports the “vector” graphics used in many of the
earlier games. In the Spectrum and several other versions these are embedded
within the game and Level 9 will usually be able to find the picture data
within an .SNA file. On other platforms (for example PC, Amiga and Atari
ST) the pictures came in separate files. To use these they need to be in the
same folder as the game data file and to be renamed thus:

• If the game data file name ends in “.dat” then the picture file should be
the same except it ending in “.pic”. For example the game data file
“gamedat1.dat” would need to be matched with a picture file called
“gamedat1.pic”.

• If the game data file does not end in “.dat” then the picture file must
have the same name as the game file but with “.pic” appended to the
end. Again, for example, the game data file “Snowball” would need to
be matched by a file called “Snowball.pic”.

Yes, I may at some point modify L9Cut to extract picture data and may also
write a utility to fuse separate graphics and data files into one for greater
convenience.
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Just to avoid confusion I should make it clear that the graphics files referred
to here are the ones where in the original distribution there is one graphics
file and for each game. The later games (which had bitmap graphics) used
multiple picture files and these will not work with Level 9 version 3.0

A note on game versions
Level 9 released their games in several different versions. Level 9 can play
most but not all of them. The following explanation/description is very
lightly adapted from David Kinder’s note “Level 9.txt’ which also
accompanies this distribution.

• v1 Used for the very earliest releases. Games which were released in this
format include      Colossal Adventure    ,      Adventure Quest   ,      Dungeon Adventure   ,
Snowball    and     Lords of Time    . Level 9 version 3.0 does not support this
version.

• v2 Used between 1984 and 1985. Games in this format were:     Return to
Eden    ,     Lords of Time    ,     Red Moon    ,     Erik the         Viking    ,     Emerald Isle    .

• v3 Appearing in 1986, this format was used by:       Worm in Paradise    ,     The
Price of         Magik    ,     The Growing Pains of Adrian Mole    ,     The Jewels of Darkness
Trilogy     (Colossal Adventure, Adventure Quest and Dungeon Adventure
released as one package),     The Silicon Dreams Trilogy     (Snowball, Return to
Eden and Worm in Paradise)

• v4 This was used for the     Time and         Magik Trilogy     (Lords of Time, Red
Moon and The Price of Magik), and all Level 9's new games from 1987
onwards:     Lancelot   ,      Knight Orc   ,      Gnome Ranger   ,    Ingrid's Back     and     Scapeghost   .

Level 9 supports version 2, 3 and 4 but not the sub-form of version 4
sometimes called version five or “split data file” which was used on some
Spectrum and Commodore releases.

A note on data file names
Generally it doesn’t matter very much what a game data file is called. If it in
one that Level 9 can understand and you ask it to open it, it will. There is one
group of games where the name, or more precisely its format is important.
On the PC, Amiga, Atari and Mac (and maybe other platforms) the version
four games were released with three game data files. These were usually
named something like:

gamedat1.dat, gamedat2.dat, gamedat3.dat

and when you started the game a menu would ask you to choose which one
of the three games you wanted to play 1, 2 or 3. Level 9 reproduces this
behaviour and to do so requires that the three files be named as follows. The
first part of the name can be any text (that your file system is happy with!) but
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must be the same for each file, next must came a number either 1, 2 or 3 and
then a “.dat” suffix. So, for example the following:

gamedat1.dat, gamedat2.dat, gamedat3.dat
KnightOrc 1.dat, KnightOrc 2.dat, KnightOrc 3.dat
FooBar1.dat, FooBar2.dat, FooBar3.dat

would all be valid for the three games of the version 4 “Knight Orc” trilogy.

Game file type
 Having obtained your game data file it will help (although it isn’t essential) if
its type and creator are set so the OS recognizes it as a Level 9 file. You can do
this either by dragging the file(s) onto the “Game Typer” tools found in the
“Utilities” folder or onto L9Cut. The “Game Typer” tools will change the
type of the file you drop on it, L9Cut will produce a new file with the correct
type &c. A correctly typed game data file will look like this:

Note that the two “Game Typer” tools are AppleScript droplets. You need to
use the one specific to your OS version – the “(MacOS X)” version will not
work on earlier versions of the OS and the “(Classic)” version will not work
on OS X.

Support

If you have any questions, please contact me not Glen Summers (I don’t think
he has anything to do with Level 9 these days.) I will do my best to respond
to email inquiries sent to      Alan Staniforth <alan@apollonia.org>     fairly
promptly but if I am away on holiday or occupied with work related matters
then there will be delays. Level 9 is a personal project, maintained in my free
time. I do my best within those constraints to help people with problems and
queries. I do though reserve the right to decide that a particular query is too
complex to deal with.

Credits/Acknowledgements.

Level 9 is copyleft freeware and was written by Glen Summers with game
data information from Paul David Doherty. Version 3.0 was developed by
David Kinder. Many people have contributed data and time to the project.

I owe a great debt of gratitude to all those public spirited people who have
made Mac code samples available from various sources, particularly Marco
Piovanelli for the WASTE text engine, Metrowerks for CodeWarrior and the
many contributors to comp.sys.mac.programmer.* from whom I have learnt
so much over the years.

mailto:alan@apollonia.org
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Installation

Extract Level 9, the “Utilities” folder and any documentation you want
available from the distribution archive and put them in a convenient folder.
The application is distributed in “FATCarbon™” form which means it will
run either under 68K or PPC if you are running OS 9.2 or earlier and under
Carbon if you are running OS X

The file “WASTELib:

must be either in the same folder as Level 9 or in the “Extensions” folder (use
/Library/CFMSupport or ~/Library/CFMSupport instead of “Extensions”
under OS X.)

Launching Level 9.

There are three ways you can launch Level 9; Firstly via double-clicking the
application, a game file or a saved game file; secondly via Drag-and-Drop and
thirdly via Apple Events.

Double-Clicking

• Just like virtually every other application you can launch Level 9 by
double-clicking its icon. After it launches you will see a menu bar looking
much like this:

or this in MacOS X:

• If you double-click on a game file then the application launches and
the game starts running. Level 9 makes a guess (based on the text that is
displayed) at which game is running and sets the window title appropriately.
If it can’t identify the game it just uses “Level 9”. The newly opened
window will look something like this:
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If an adventure is already running the new one will start in a new window. If
it can’t find the game a window will open with an error message in it
reporting the problem.

• If you double-click on a saved game file:

then Level 9 will launch and if it can find the game data file belonging to that
save game file it will load that game and restore the position from the saved
game file:

Level 9 Interpreter

Welcome to Colossal Adventure, the first of the Jewels of
Darkness, copyright (C) 1986 Level 9 Computing.

(This version allows you to use RAM SAVE and RAM RESTORE to save
a position in memory, and OOPS to "take back" bad moves).

You are standing beside a small brick building at the end of a
road from the north. A river flows south. To the north is open
country and all around is dense forest.

What now?

Game restored.

What now?
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You are in open countryside. A road leads to a building in the
south, surrounded by woods. A spire rises into the clouds
beyond.

What now?

If Level 9 can’t find the game file a window will open with an error message
in it reporting the problem:

Level 9 Interpreter

Unable to load: Bones :Development:MyProjects:Level 9:Jewels of
Darkness (PC):COLOSSAL.DAT

Error: Unable to open game file

Press any key.

Under some circumstances with some games the attempt to restore may not
may not work, even if Level 9 can find the game file — see the “Known
Problems” section for more information.

Drag-and-Drop

Drag-and-Drop to the Application Icon
This works exactly as you would expect from the last section. Drop a game
data file or a saved game file on the application icon and the application will
launch (or switch to the front if already running) and the game you dropped
will start running or be restored as described above.

Apple Script

You can also control Level 9 via AppleScript. Here’s an example script:

tell  application "Level 9"
        activate
        open {alias "Macintosh HD:Level 9 Games:Colossal.dat"}
end  tell

Compile and run this and Level 9 will launch/come to the front and start the
game you have indicated. If you send multiple files each will be opened.

This very limited AppleScript repertoire is recordable.

I may expand the AppleScript dictionary in future versions and hope to
continue to keep things recordable. A long term project is to allow someone
to play a game via AppleScript.
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Playing Games in Level 9

General Play

I’m not going to cover the commands etc. actually used to play the games.
Those, obviously, are specific to each game (although many commands are
used by all games.) From the play point of view you simply type your
commands in at the prompt in the console window exactly as if you were
playing it on the original hardware.

If you have lost your manuals and can’t find details of game specific
commands or even general details of how to play, take a look at:

http://ifarchive.org/indexes/if-archiveXLevel 9Xmanuals.html   

and the game novellas can be read at::

http://members.netscapeonline.co.uk/jeremyalansmith/Level 9/    

Starting a Game

As described above you can start a game by double-clicking or dragging-and-
dropping the game data file or a saved game file. Alternatively, if Level 9 is
running you can choose “Open” or “New Game…” (from the “New” sub-
menu.)

In either case a Standard File (or Navigation Services) dialog opens which
allows you to select either a game data file or a saved game file to open. The
effect is exactly the same as double-clicking on the same file.

http://ifarchive.org/indexes/if-archiveXLevel
http://members.netscapeonline.co.uk/jeremyalansmith/Level
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There is a slight difference between the two menu operations. “New
Game…” will only allow you to choose a game data file or saved game file.
“Open” will allow you to select text files as well, which brings us to:

Starting a New Game in an open Game Window
This is slightly different! If you drag a game data file to a game window the
current game will be replaced by the new game. Here’s an example of Knight
Orc being dropped into a window where Colossal Adventure is already
running:

Level 9 Interpreter

Welcome to Colossal Adventure, the first of the Jewels of
Darkness, copyright (C) 1986 Level 9 Computing.

(This version allows you to use RAM SAVE and RAM RESTORE to save
a position in memory, and OOPS to "take back" bad moves).

You are standing beside a small brick building at the end of a
road from the north. A river flows south. To the north is open
country and all around is dense forest.

What now?

Welcome to Knight Orc, copyright (c) 1987 from Level 9 Computing
and Rainbird. (This version allows you to use RAM SAVE and RAM
RESTORE to save a position in memory, and OOPS to take back bad
moves).

Grindleguts struggled awake, groaning piteously. The world
bucked and swayed, his headache was agony and he ached in every
limb. Grindleguts' mouth tasted like a Hobbit's armpit and he
seemed to have lost another tooth - he could not quite remember
what had happened after they captured the Inn, yesternight, but
he was sure it must have been fun! He moaned again and prepared
to wallow in his hangover.

A sharp object stabbed at Grindleguts' ribs again, interrupting
his enjoyment of his misery. Grindleguts risked ungluing one
bloodshot eye and squinted at the world. A shaft of sunlight
stabbed back. It was still light. It was very light! Some idiot
had woken him in the middle of the day!

What now?

Opening/Creating a Text Document

Level 9 incorporates some basic text editing functions and this allows you to
keep notes as you play a game. You can create a new text document by
choosing “New Text Document…” (from the “New” sub-menu). You can
open one via the “Open” option from the “File” menu or by drag-and –drop
(or double-clicking if it’s a Level 9 text document.) When a text document is
open in the front window the “Game” menu title changes to “Document”.
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Saving a Game

While playing the “save” command issued from the command line allows
you to save your current position. You can also save the game by choosing
the “Save” option from the “File” menu which issues a ‘save’ for you. As
yet there is no menu option for ‘restore’.

Issuing this command opens a save file dialog (either Navigation Services or
Standard File):

For greater authenticity (at some cost in convenience) you can set a preference
flag (see preference section) that will let you use the standard method of
entering the file path name on the command line.

Saving a Game Log

You can save the text in the terminal window as a log if you want a quick
way of remembering/reviewing your play to date. To do this, choose the
“Save Terminal Text…” option from the “File” menu and a Save As…
Standard File dialog opens to allow you to choose where to save the file. The
saved file is a Level 9 text file and can be opened for editing in the game or
any text editor.

This does not allow you to use “Command-S” as a short-cut to update the
log. That will still trigger a save of the game.
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Saving a Text File

A new text file can be saved by choosing the “Save As…” option from the
“File” menu and subsequently updated by choosing “Save” option from the
“File” or pressing Command-S.

Restoring

By Terminal Commands
While playing the “restore” command allows you to restore a previously
saved position. (There is currently no direct menu equivalent of this unlike
“Save”, “Open” does not issue a terminal command but acts the same way
as double-clicking or drag-and dropping a file to the application icon.)

 As with ‘save’, by default issuing this command opens a Navigation
Services/Standard File Open dialog to save or select a file as appropriate:

In the case of a ‘restore’ you may have to answer a copy-protection question
first. The same preferences option as for ‘save’ allows you to omit the file
selection dialog and use the command line only to specify the file.

By Drag-and-Drop to a Game Window
You can restore a game position by dragging a save game file to the game
window:
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the running game will be restored or a new game loaded as appropriate. If
the saved game file doesn’t match the running game you will be prompted to
confirm you do want to restore with that game:

Level 9 Interpreter

Welcome to Colossal Adventure, the first of the Jewels of
Darkness, copyright (C) 1986 Level 9 Computing.

(This version allows you to use RAM SAVE and RAM RESTORE to save
a position in memory, and OOPS to "take back" bad moves).

You are standing beside a small brick building at the end of a
road from the north. A river flows south. To the north is open
country and all around is dense forest.

What now?

Warning: game path name does not match, you may be about to load
this position file into the wrong story file.

Are you sure you want to restore? (Y/N)

Sorry, unrecognised format. Unable to restore

You are standing beside a small brick building at the end of a
road from the north. A river flows south. To the north is open
country and all around is dense forest.

What now?

Additional Methods of Restoring
In addition to issuing the two techniques described above you can also
restore saved positions by double-clicking on the saved game file, by
dragging it to the application icon or by choosing it from the dialog opened
by choosing “Open…” option from the “File” menu. All these behave in
much the same way once a file is chosen. Level 9 will try to load the file as a
restored position if (a) there is only one game running and (b) it appears to
match the running game.

If the Running Game Doesn’t Match

If it doesn’t match the running game then this Alert opens:
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The options are pretty clear. You can either start a new game that matches the
save game, cancel or restore. PLEASE NOTE: If the saved game file doesn’t
really belong to the game being played and you choose “Load”, the
interpreter will crash, so be careful.

A little note on restoring. Level 9 tests whether a save file matches a running
game by checking to see if the game file path name stored in the save game
file matches the pathname of the running game. So, in practice, if the game
data file has been moved between when the saved game file was created and
when this game was started then Level 9 will think the saved game file
doesn’t match. In this case it is entirely safe to load the game. However trying
to load a saved game from one version of the adventure into another may
well fail.

More than One Game Already Running

If there is more than one game already running you will see the following
dialog:
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Again, pretty self explanatory. When you select a game in the list the “Load”
button will high-light. The warnings in the previous section about loading a
game into the wrong game apply here as well.

Problems with Restoring in some Three-Part Games

All of the restore methods described above (except entering ‘restore’ on the
command line) use the same code as used by the ‘#restore’ command
(described in the “Special Commands” section.) This is important because this
code has limitations that ‘restore’ does not. In the later three part games if you
use ‘restore’ you can safely restore to a position in a different part of the game
to that which you are currently playing. The game takes care of this for you
behind the scenes.

The ‘#restore’ code however does not do this. If you are playing part 2 of
“Scapeghost” and want to restore to a position in part one you would need to
load a new game playing part one first. This doesn’t sound two much of an
imposition however with some of the later three part games you cannot do
this. Specifically “Knight Orc”, “Gnome Ranger” and to and extent
“Lancelot” will not let you load and run a specific part instead forcing the
load of any part to start part one running. The only solution is to use the
“proper” ‘restore’ so the game does the loading of the needed part for you. I
may be able to fix this in a future version but please don’t hold your breath, it
is extremely tricky. Please note: in the early three part games — those where
each part was originally written as an individual adventure — even ‘restore’
will not restore between sections of the game.

Issuing Commands

Basic Function
Type the command at the prompt in the game window and press <Return> or
<Enter>. For example:

You are standing beside a small brick building at the end of a
road from the north. A river flows south. To the north is open
country and all around is dense forest.

What now? look. south. south

You are standing beside a small brick building at the end of a
road from the north. A river flows south. To the north is open
country and all around is dense forest.

You are in a valley beside a stream which cascades along a rocky
bed on its way south. The valley is lined by woodland trees and
you can hear birds singing from their branches.

You are in a tree-lined valley beside a stream which seeps away
down many small cracks in the ground. Downstream, to the south,
the valley narrows and the streambed contains only dry rocks.

What now?
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It doesn’t matter where the insertion point is when you press <Return>. If the
insertion point is not at the end of the command text the whole command text
is still submitted. For example if you press <Return> at this point with the
insertion point before the second south:

You are standing beside a small brick building at the end of a
road from the north. A river flows south. To the north is open
country and all around is dense forest.

What now? look. south .| south

The result will be exactly as shown in the example above.

You can type and enter a command while the new “atmospheric” graphics
are drawing. There is no need to wait for completion of the picture.

Using the Selection as a Command
If you select some text further back in the window, like this:

and then press <Enter> the selected text is issued as a command. The result
would look like this:

You are in a valley beside a stream which cascades along a rocky
bed on its way south. The valley is lined by woodland trees and
you can hear birds singing from their branches.

What now? south

You are in a tree-lined valley beside a stream which seeps away
down many small cracks in the ground. Downstream, to the south,
the valley narrows and the streambed contains only dry rocks.

What now? south

You are in a 20-foot depression in a deep, narrow valley sloping
down to the south. The steep sides of the valley are overgrown
with brambles.

There is a large padlocked grate set into the ground.

What now?



Level 9 – Level 9 Game Interpreter 17
_________________________________________________________________________________

Using a Script
Level 9 provides a way to execute a whole series of commands automatically.
If you enter the commands in a text file and place them in the folder called
“Scripts” which you will find in the folder “Level 9” which you will find in
the “Preferences” folder. Text files placed in here will appear in the sub-menu
“Scripts” of the “Game” menu:

Editing the Command Line

A command line can be edited by standard Macintosh text editing
conventions. The arrow keys move left and right, up and down (if the
command covers more than one line — otherwise up and down move you to
the beginning and end of the line respectively.). Copy, Cut and Paste work as
usual – both by the usual keyboard short cuts and via the “Edit” menu.

You can also use drag-and-drop to edit your text.

Command Line Recall

New in MacOS version 2.1 is a command line history. If you press
<Control>+<Up Arrow> the current command line will be replaced by the
previous command line. This can be repeated back through the previous 48
commands. As you might expect, <Control>+<Down Arrow> moves you
back down through the command history. A recalled command line can be
edited before being submitted.

Editing Non-Command Line text

Text before (and including) the current prompt cannot be altered. You can
select it for copying or drag-copying but cannot cut it or paste new text in or
move text around within it.

If you wish to edit text in this area for a log, notes or similar purpose, copy it,
paste it into a new text document and save that.
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Closing a Game

• To finish playing a game choose “Close” from the “File” menu or
click in the window’s close box. The window will close immediately. NOTE:
You will be prompted to save the game unless you have changed this
behaviour via the “Preferences…” dialog..

• The ‘quit’ command issued at the command line doesn’t quit the game,
it just restarts it.

• Also see the “#quit” command described below for yet another
behaviour.

Special Commands

In addition to passing your typed commands through to the interpreter
engine Level 9 implements a number of commands for special purposes All
are indicated by having a hash symbol “#” as their first character. They are as
follows:

#restore
This acts like a command line version of double-clicking a save-game file in
the Finder. You are prompted for a file name and the interpreter tries to load
that file as a saved game position. The advantage of this command over s
simple “restore” is that it bypasses any protection mechanism built into the
game – e.g. manual lookup, LensLok etc. Please note though the limitations
on its use in some three part games described in “    Problems with Restoring in
some Three-Part Games   ” above

#save
This command bypasses the interpreter when saving and so omits some
annoying prompts.

PLEASE NOTE: I haven’t tested this extensively but the moderate amount of
testing I have done has found no problems.

#quit
When this command is issued the game stops running and the window
closes. Again, this is not an application quit command, just a game quit.

#picture
If graphics are available, shows the picture specified as a number after the
picture command, e.g. "#picture 520".
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#cheat
A bypass for the protection which asks you to look up a specific word in the
manual. #cheat will find and enter it for you.

#dictionary
This command lists all the words in the game’s dictionary.

Preferences

The “Preferences…” option at the bottom of the “Edit” menu (or the
second item on the “Level 9” menu under OS X) opens a dialog which
allows you to set various default aspects of Level 9’s behaviour.

The upper part is simple enough.:

Default Font: This pop-up menu allows you to set the default font that
Level 9 will use in a game window.

Default Text Size: This pop-up menu and associated editable text box
allow you to set the default size of text in a game window.

Plain Text, Bold, Italic, Underline, Outline, Shadow, Condensed
and  Extended: These check boxes are used to set the default style of game
window text.
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Default Colour: This pop-up menu allows you to set the default colour
used for game window text.

Default Background Colour: This pop-up menu allows you to set the
default background colour used for game windows.

(Sorry for the limited colour choice – I may find a way to extend this in
future, but for the moment I’m sticking with this basic set.)

Use Atmospheric Graphics: If graphics are available then checking this
preference causes Level 9 to display them by drawing them in stages as the
original games did.

Graphics Ops Per Step: If atmospheric graphics seem to be displaying too
slowly for you (they should take a maximum of about five seconds) then
increasing the number in this preference may speed things up for you. If even
that is not fast enough it is probably best to disable atmospheric graphics.

Reducing the number will increase the number of steps taken to draw a
graphic if you feel that is more authentic (This will slow graphics down on
some machines, with very low numbers on almost any machine.)

Confirm Closing Unsaved Game Window: If you try to close a window
having made moves since your last save you will be prompted to save the
game before closing.

Use Mac dialogs for save/restore: Toggles the use of Mac Standard
File dialogs by Level 9. If this is unchecked then Level 9 will ask you to enter
file names for opening or saving to on the command line; if checked Level 9
will use Standard File dialogs.

Set Default Window Size: Clicking on this button opens a window
whose size you can adjust to set the default size of new game windows.
Clicking in the close box or using <Command-W> accepts your changes,
<Command-.> ignores your changes.

Please note that the set size will not (usually) be exactly used by new game
windows as they are adjusted to ensure that an exact number of lines fit in the
text space and ensure that the window will fit on your screen.

Graphics

As you can see from the illustrations this version of Level 9 supports one of
the forms of graphics used by the various version of Level 9 games. If they are
embedded in the game data file or are in a properly named file Level 9 will
detect their presence and display them. If you don’t want them enter:

text
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at the command line and they will vanish. Similarly, entering:

graphics

will make them reappear.

The games known to have these graphics are the “Jewels of Darkness” and
“Silicon Dreams” trilogies,  and some versions of “Emerald Isle”, both Adrian
Mole games, “Erik the Viking”  and some versions of the “Time and Magik”
trilogy (the C64 console and possibly some Speccy versions).

The graphics size increases and decreases with the size of the window but is
never larger than twice the original size.

In this new MacOS version (2.1) there is now an option to have the graphics
draw “atmospherically”, IE in stages as the original games did. This can be
activated/deactivated via the last item on the “Game” menu:

And globally for each new game via the “Preferences…” dialog.

Changing the Game Window

Basics

You can do all the usual things you would expect to be able to do with a Mac
window. Move it around, change its size, zoom it, etc.

One small note on Zooming. The zoom box toggles the window between
whatever was the last size you set it to by dragging the grow box and the
“Standard” size — the size that either (a) shows double the original game’s
graphics size exactly; or (b) fits completely within your screen boundaries;
whichever is the smaller.

Changing the Text with the “Game” Menu

The “Game” menu contains various sub-menus which let you change the
appearance of the text in the game terminal window and its background
colour. The submenus are “Font”:
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which, obviously enough, will allow you to set the font the window uses and
also as you would expect displays all the active fonts you have installed on
your system.

 The next sub-menu is “Size”:

which again obviously enough changes the size of the terminal text. The
“Style” submenu:

allows the use of the standard QuickDraw styles for the terminal window text
and “Colour” and “Background Colour” both allow you to choose one of
eight colours for the terminal text and its background.

The use of the “Do Script” submenu was described in the “Issuing
Commands” section above.
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With all these commands the entire terminal text changes, not just the
selection.

When you have a text document rather than a game as the frontmost window
the “Game” menu changes it’s title to “Document” menu.

Using the “Document” Menu with Text Documents

If you have a text document front-most the “Document” menu behaviour is
somewhat different.  To start with the “Do Script”, “Background
Colour” and “Graphics” submenus are disabled.

Secondly, the change is applied only to whatever text you have selected in the
window.

The “Window” Menu

This shows all the currently open windows and choosing a window from it
brings that window to the front. In addition it has two other items:

“Minimize” and “Bring All to Front”. “Minimize” is only enabled if the
Appearance Manager is available or in Mac OS X and is used to either shrink
the window to its title bar (MacOS 9.2 or earlier) or shrink it to an icon in the
Dock (MacOS X.)

“Bring All to Front” is only enabled in MacOS and has the usual
behaviour of bringing all Level 9’s windows to the front.

Known Problems

• Carbon Version only runs under OS X

This is a deliberate choice on my part. Event handling under Carbon when
running on a “classic” OS version seems very slow with the result that long
text passages (e.g. the #dictionary output) display slowly. If you really want a
Carbon version that runs under OS 8.1-9.2+ CarbonLib please let me know
and I’ll send you one.
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• Navigation Services File Type Pop-up Menu Broken Under
Classic OS Versions

In theory the Navigation Services dialog allowing you to choose a file to open
should have a pop-up menu at the bottom  which looks like this:

For some reason I do not understand this does not work under Classic
versions of Mac OS (although it’s fine under OS X). Under classic versions of
the OS the pop-up looks like this (or similar):

I have no idea what is happening here and nothing I have tried has fixed it so
I have disabled this pop-up for the time being under classic OS versions. This
allows any file to be chosen.

• Restore Problem

As described in “    Problems with Restoring in some Three-Part Games   ” you
cannot use this command to restore to a different part of a three part game to
that which you are playing. I may be able to get a work round for this but it
isn’t a priority at the moment. Even if I can, it still won’t work for the early
games where each part was written as an individual adventure as even
‘restore’ doesn’t work between games for these.

Futures

I will do my best to keep this up to date with any publicly released changes to
the main source.

I hope to add better Apple Event support.
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Improved logging.
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